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Micro Focus Enterprise Server 3.0 Release
Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note:

• This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link.
Web sites by their nature can change very rapidly and although we try to keep our links up-to-date,
we cannot guarantee that they will always work as expected.

• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro
Focus Infocenter for any updates to the documentation which might have been uploaded.

Product Overview

Enterprise Server provides the execution environment for applications created with any IDE variant of
Enterprise Developer.
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What's New
This release provides enhancements in the following areas:

• Application Server JCA support for Enterprise Server
• CICS Web services
• Data File Tools
• Database access - HCOSS
• Deployment on multiple platforms
• Documentation
• Enterprise Server
• iFileshare
• IMS support
• Mainframe Access (MFA)

Application Server JCA support for Enterprise Server

In this release, EJBGEN has been updated to generate an EAR file as a part of the COBOL deployment
process, which enables you to deploy EJBs to Java Application Server.

Back to Top

CICS Web Services

In this release, CICS Web services support includes the following additional features:

• CICS JSON Web services for request/response and RESTful JSON. CICS Web Services support has
been extended to allow JSON/REST requests to be used in both requestor and provider mode.

• Use of container-based mappings

Back to Top

Data File Tools

This release provides the following enhancements to Data File Tools:

• Opening files in shared mode - it is now possible to switch between read-only shared and edit modes.
While a file is open in shared mode, others users can only open it in shared mode to ensure data
consistency between users.

• Enterprise Server-level of security when accessing files - there is an improved level of security when
exchanging data between Data File Tools and the targeted enterprise server instance. Users must now
provide a user ID, group and a password when they try to access and view datasets in enterprise server
instances. These are used for authentication and authorization checks to provide the same access level
as Enterprise Server.

• Opening datasets using SSL - communication to a region is now possible using SSL. To enable the SSL
communication, you need to provide a Java trust store which contains either a CA root certificate or a
self-signed certificate of the region that it is communicating to. Java and the targeted region SSL
configurations need to meet each other's standards in order for the communication to succeed.

This feature enables you to secure the information exchange between Data File Tools and the targeted
enterprise server.

• Auditing of access and updates on datasets - Audit Manager now audits the access and updates on
datasets via Data File Tools.

• Support for existing .pro files - enables you to use your existing editor profiles.
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• Support for existing .str files - enables you to use your existing COBOL and PL/I structure files.
• Automatic timeout - if no internal operations or external actions (such as a mouse click) have been

detected for 30 minutes, Data File Tools now displays a countdown message. If the user does not take
any decision within the specified period, Data File Tools closes all opened files.

Back to Top

Database access - HCOSS

This release provides a new Offline Schema Extract feature – a batch solution that migrates a z/OS DB2
catalog to SQL Server without direct access to z/OS DB2.

Back to Top

Deployment on multiple platforms

This release provides support for deploying JVM COBOL applications on multiple platforms. You can
compile an application on one platform (such as Windows) and then deploy its class files to a different
platform (such as Linux or UNIX).

Some features of the COBOL language, however, are platform-specific and their behavior on different
platforms might vary. See Multi-Platform Deployment of JVM COBOL Applications in your product Help for
details.

Back to Top

Documentation

The following new sections have been added to the product help:

• Where do I start? - located on the launch page of the product help, this section provides the information
you need in order to get started depending on which aspects of the product you need to get to grips
with first.

• Multi-Platform Deployment of JVM COBOL Applications - includes information about how to ensure the
portability of your JVM COBOL applications between Windows and UNIX or Linux platforms.

• Configuring an SSL Client Connection to a Mainframe - includes instructions about how to configure
client applications to connect to MFA and z/Server mainframe via AT-TLS in a zOS environment.

Back to Top

Enterprise Server

Improvements are available in the following areas:

EXEC CICS TRANSFORM:

• Enterprise Server now supports the XMLTODATA and DATATOXML options of this API.

JCL spool

The JCL spool repository infrastructure has been redesigned to significantly improve its performance. The
improvements include:

• A more disk-efficient infrastructure, reducing the space required by the spool files by up to 75% in some
cases.

• Improved internal indexing, resulting in quicker generation of messages and sysout records during
processing.

• Improved navigation of spool queues: job status Complete replaces the Output, Out Hold, and
Printed statuses, and completed jobs with any combination of sysout files can be displayed in a single
list.

• Increased range of job numbers, from five digits to seven digits.
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Important: These changes are automatically in place for new enterprise servers that you create.
To enable these updates to existing enterprise servers, you must run a conversion utility before
any JCL processing is permitted. Follow the To run the spool conversion utility process,
detailed in Significant Changes in Behavior, for each existing JES-enabled enterprise server you
have.

Long user IDs and passwords:

• Enterprise Server now supports user IDs and passwords of up to 100 characters. It is possible to map
IDs from long to short (or vice versa) to enable compatibility with programs that do not support long
names.

Multi-factor sign-on:

• Multi-factor authentication enables users to sign on to Enterprise Server CICS without entering a
username and password. A secure user identifier, such as a certificate, is mapped to a username and is
used to generate a passtoken. It is possible to use smartcards, biometrics, or other authentication
systems to identify yourself to the system. The username and passtoken can then be used to log on to
CICS in an automated way.

The supported sign-on mechanisms are Express Logon Feature (ELF) and Automated Sign-On for
Mainframe (ASM). See the product Help for examples of how to configure a region to use the two
mechanisms.

SHA-256 support in DemoCA:

• By default, the Demonstration Certificate Authority (CA) now signs certificates with SHA-256. This
ensures that the demonstration or evaluation certificates will be accepted by modern browsers and
other software that has enhanced security requirements.

Syslog auditing:

• Enterprise Server now supports auditing using syslog events, which can be consumed by a wide range
of Security Information and Event Management (SIEM) products. This replaces the Audit Manager
auditing solution. Syslog auditing provides a much more efficient auditing mechanism, with significantly
less impact on overall speed.

Back to Top

iFileshare

iFileshare is no longer considered an Early Adopter Program, and contains the following enhancements in
this release:

• An improved failover and recovery process. iFileshare now supports full recovery of nodes in the group.
For high availability (HA-VSAM) groups, servers can now rejoin the group without the entire group
having to be restarted. In addition:

• A primary failover now results in a takeover from the most suitable node.
• If configured, external clients will automatically reconnect to the new primary and will issue a

notification if the transaction has been lost.
• A failed node, when restarted, will rejoin the group, recover its files and request a log update from

the current primary. Once this task has completed it will be considered an active hot-standby and will
continue to process replication requests as normal.

• Users will experience a higher level of uptime/availability with their Fileshare configuration and will be
able to recover from errors more easily.

• A new exit procedure, ifsexitproc.cbl, can be configured to automate some aspects of iFileshare
behavior.

• The iFileshare Control page in ESMAC contains details of the current iFileshare high availability group.
• The following new iFileshare-specific environment variables are available:
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• FSWRKDIR - enables you to specify the Fileshare working directory, overriding the default, which is
the system directory of the region.

• FSCHKLFH - determines if a check is performed when a high availability group is started, to test the
consistency of the data files within the group.

• The database reference file (dbase.ref) now supports wildcard matching for filenames, allowing you
to perform operations on multiple files at once; for example: fs /d dbase.ref /f data\* adds the
entire contents of the data directory to the database reference file.

Back to Top

IMS support

A new MFSGEN Compiler directive, CONTMVS, has been added to enable the compiler to parse MFS
continuation lines (those continued without a terminating comma) by treating the line that follows as a
comment line, just as is done on the mainframe.

Back to Top

Mainframe Access (MFA)

This release provides the following improvements:

• Running MFA client in 64-bit processes - you can now call the MFA client modules from 64-bit
applications and take advantage of the wider memory addressing available to those modules.

• MFA client CTF tracing - MFDAS now supports CTF tracing. This provides better diagnostics of issues
and helps increase turnaround on issues. CTF is common to a number of Micro Focus modules so
cross-component logging can be turned on from a single place.

• Endevor functions - the following functions are now available to Enterprise Sync and MFDAS: DELETE,
DIRX, GENERATE, GETENQI, LIST, MOVE, SIGNIN and TRANSFER.

Back to Top
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

Where present, the numbers that follow each issue are the Support Incident Numbers followed by the
Reported Problem Incident (RPI) number (in parentheses).

• CICS Support
• Compatibility AddPack
• Documentation
• Enterprise Server
• File Handling
• IMS Support
• JCL Support
• JES-enabled Enterprise Server Regions
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• OpenESQL
• PL/I Support
• Reserved words
• SQL: HCO for SQL Server
• HCO for DB2 LUW

CICS Support

Back to the list

• The value specified in the LENGTH field of the SEND TEXT command is now honored when the target
terminal has its SOSI or PS attributes switched on. This means that trailing spaces will no longer be
removed for SOSI/PS terminals.

2884877 (1107983)

Compatibility AddPack for Visual COBOL

Back to the list

Compatibility AddPack for Visual COBOL is now deprecated and will not be available with release 3.0 and
later.

The Dialog System GUI and run-time components and Dialog System Character Mode (on Windows and
UNIX) which were part of the AddPack are now installed as part of Enterprise Developer for Visual Studio.
The run-time components are installed as part of Enterprise Server. These are only included for backward
compatibility and Micro Focus does not recommend that you use them for new development.

The other components which were part of the AddPack, the Character-Based Data File Editor, CSBIND
and Screens, will be available upon request from Micro Focus SupportLine.

Documentation

Back to the list

• There have been a number of new reserved words added to the language in this release; these are all
in effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
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following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them: ALLOCATE FREE JSON END-JSON

Enterprise Server

Back to the list

• WEB CONVERSE now supports a value of 0 for the USERLEN and PASSWORDLEN options which
matches the behavior on the mainframe. There is no change to the behavior of WEB SEND (client)
which is to return LENGERR 139/140 when USERLEN or PASSWORDLEN are 0.

2989188 (1108602)

File Handling

Back to the list

• Under certain circumstances, retry-lock requests on UNIX systems were sleeping for a second before
re-attempting to acquire the lock. This no longer happens.

2988222 (1108521)
• A problem that generated a 39 error when attempting to access a VSAM file via an alternate index

PATH element has been fixed.

2874622 (1106562)
• Under Mainframe emulation, when an empty virgin VSAM file is opened for input or for input/output, a

file status of 35 is returned, regardless of the access mode specified.

2692826 (1093604)

• New PARM option SIGN-EBCDIC documented for MFJSORT.

2880037 (1107256)
• The MFJSORT ICETOOL emulation now supports the USING parameter in the SELECT operator.

2821176 (1099529)
• An empty, space-filler record is no longer produced at the end of an ICETOOL listing file.

(622789)

IMS Support

Back to the list

• Inconsistent results returned to a GET call issued from a PROCOPT=GO application when segments
within the same database record were updated and locked by another session. Symptoms included an
invalid (GE) status code or the wrong segment returned to a GN call. This has been fixed.

2862879 (1104899)

• The IMS control page is now secured according to the IMS* entity in MFESMAC.

2877405 (1107099)

JCL Support

Back to the list

• An emulation of the LE run-time option CBLQDA has been implemented in the form of the environment
variable MF_CBLQDA. The default is OFF, but when set ON, QSAM files can be dynamically created.

3104665 (1109251)
• A new event call to the JCL user exit (MFJUXIT) has been included. The event 'job-queued' (event code

27) occurs when a JCL job has been parsed and put on either the Input Ready queue or the Input Hold
queue.
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2990395 (1108734)
• When reading commands, MFFTP now checks the charset (EBCDIC or ASCII) of each concatenated

INPUT dataset to determine if it should be translated. The output is written in the charset which
appropriate for the dataset.

2876407 (1106795)
• The PHYSFILE security setting will now be checked when a dataset entry is inserted into the catalog, or

when a dynamic PDS member is created.

2857819 (1104844)

JES-enabled Enterprise Server Regions

Back to the list

Important: Existing JES-enabled Enterprise Server regions must perform this upgrade to continue
using JES functionality. If you start a region without upgrading, the following message is displayed in
the console log, and JES functionality is disabled:

JES000058E JES validation - Product requires new spool control files. Run
spool conversion utility, splconv, to create them.

In this release, the infrastructure of the JES spool repository has been upgraded in order to improve
performance (see the Enterprise Server section of What's New for more details). For each JES-enabled
region, before you can submit any jobs to JES, you must run the spool conversion utility; any newly created
regions will automatically be configured to use the new spool files.

The conversion process converts the information in the existing spool files to a set of new files required
under the new system. There should be no loss of data in moving to the new system.

Important: After converting to the new JES spool infrastructure, we recommend that you do not
employ the increased range of job numbers until you have thoroughly tested the new infrastructure.
Reverting back to the previous JES spool files is possible, but requires that you remove all job entries
using more than 5 digits, for which there is no easy process.

To run the spool conversion utility

1. At the Enterprise Developer command prompt, set the following environment variables, as required:

Variable Description

MFSYSCAT The location and name of the current JES catalog. This
is mandatory.

If multiple catalog files are being used (that is, one or
more user catalogs are defined), this environment
variable should point to the catalog where JES spool
datasets are cataloged.

MVSSPOOLDIR The location of the current JES spool files. This is only
mandatory if the location is different to the location of
the JES catalog.

NEWSPOOLDIR The location for the resulting JES spool files (that is, the
SPL* files if running the conversion, or the old-style
spool files if running the regression). This is only
mandatory if the location is to be different to the location
of the existing spool files.

MFSYSCAT_ERRS The number of catalog errors that will be tolerated
during the conversion process before the conversion is
terminated. This is optional, and defaults to 100.
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Variable Description

If the process is terminated, the following error is
produced:

MVSCATIO Error limit exceeded = nnnn
(where nnnn is the error count)

2. Type splconv, then press Enter.

The conversion process runs, and details of the files and records converted are displayed to screen.
3. If MVSSPOOLDIR and NEWSPOOLDIR were set to different locations prior to running the conversion,

you must now set MVSSPOOLDIR to the value of NEWSPOOLDIR.

Note: If you do not perform this step, you will receive the following error when you start your
region, and JES fails to initialize:
JES000058E JES validation - Product requires new spool control files. Run spool conversion utility,
splconv, to create them.

4. You can now start the region identified by the variables, and begin to submit jobs.

Reverting to the previous JES spool repository

If you plan to downgrade to an older version of your current product, any enterprise server region that has
been converted or created with the current product will not be compatible. Before you can use them, they
must be reverted to using the old JES spool repository.

Use this process if you are wanting to use a JES-enabled region in a previous version of the product:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to PRE30.
3. If the region has started to use 6- or 7-digit job numbers (an enhancement new to version 3.0 of the

product), then before you run the regression, you must remove the jobs that are using these numbers,
and ensure that the MF_MVSJOB environment variable (or the SPLJNO.dat file if the variable is not
used) does not specify an upper limit greater than 5 digits.

Note: If using the MF_MVSJOB environment variable, to revert to 5-digit job number support, set
MF_MVSJOB=<low number>+<high number>, where high number is less than 0099999, and
ensuring that the + sign is used to separate the low and high values.

4. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.

You can now use the region identified by the variables in previous versions of Enterprise Developer.

Exporting the spool files to Enterprise Server for .NET

If you plan to export a region to Enterprise Server for .NET, any enterprise server region that has been
converted or created with the current product will not be compatible. Before you can use them, they must
be reverted to using the old JES spool repository.

Use this process if you are exporting a JES-enabled region to Enterprise Server for .NET:

1. At the Enterprise Developer command prompt, set the environment variables listed in the To run the
spool conversion utility process, as required.

2. Set an additional variable, SPLREGR_TARGET, to the appropriate value:
DOTNET5

Create spool files for use on Enterprise Server for .NET, using a maximum of 5 digits for
job numbers.

DOTNET7
Create spool files for use on Enterprise Server for .NET, using a maximum of 7 digits for
job numbers.
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3. Type splregr, then press Enter.

The regression process runs, and details of the files and records converted are displayed to screen.

You can now use the region identified by the variables in Enterprise Server for .NET.

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSI no more requires that the name of the last folder specified in the path in MFBSI_DIR matches
the name of the target Enterprise Server region. It is now possible to specify any directory path in
MFBSI_DIR. You must use the same value for MFBSI_DIR in both the Enterprise Server configuration
and for MFBSIJCL execution. When the name of the last folder specified in the path in MFBSI_DIR
does not match the name of the target Enterprise Server region, you need to specify the region name in
one of the following ways: 1. From the mfbsijcl command line, using the parameter
REGION=ESRegionName. 2. In an MFBSI configuration file, in a line containing
REGION=ESRegionName. You can specify this either in the default configuration file, mfbsi.cfg located
using the path specified by MFBSI_DIR, or using a custom location or configuration file and the
following parameter: CFG=[path]/name[.ext] See your product help for more details.

2869805 (1105939)

Micro Focus Directory Server

Back to the list

• In the Enterprise Server Administration HTML GUI, the "Scripts" page functionality is only available if
administration access is restricted and the logged on user has sufficient authority.

3101625 (1109025)
• Some additional CSRF security measures have been added to the Enterprise Server Administration

HTML GUI.

3101205 (1108916)

OpenESQL

Back to the list

The new OpenESQL OPTIMIZECURSORS SQL compiler directive option is turned on by default for both
ADO.NET (DBMAN=ADO) and ODBC (DBMAN=ODBC). For ADO.NET, this reduces cursor memory
consumption thereby providing optimal performance. This also ensures that, for ODBC, embedded SQL
cursors that use WITH HOLD and FOR UPDATE clauses have the same data integrity across all
databases.

If your applications require the OpenESQL preprocessor to use the behavior provided in an earlier release,
compile them using OPTIMIZECURSORS=NO.

PL/I Support

Back to the list

• PUT output-items of type POINTER are now output as a hexadecimal string rather than a fixed bin
integer value.

(623184)
• Enterprise Developer 3.0 includes some changes that result in a significant performance improvement

when assigning a null character string '' to arithmetic data items, pointers, and structures. In versions of
the product earlier than 3.0, pointer = ''; assigned the value sysnull(). This has been fixed and null() is
now assigned. See the product help for details about the -setnull compiler option.

(627517)
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• Previously, if writing output to a CTLASA (PRINT) file with the optional LINE(x) parameter having a
value of x that was less than the current line, PL/I did not generate ASA Control characters to end of
page and emit the output on the first line of the new page. This no longer occurs.

2871278 (1106114)

Reserved words

Back to the list

• There have been a number of new reserved words added to the COBOL language; these are all in
effect under MFLEVEL"19", which is the default level when running under the MF dialect. Any of the
following words are now not allowed under default conditions, and you will need to remove/rename
them, or specifically configure your environment to allow them:

ALLOCATE
FREE
JSON
END-JSON

SQL: HCO for SQL Server

Back to the list

• The HCOSS Assess Application Migration tool now enables you to view the original DB2 SQL and the
converted TSQL together in both the HCOSS tool itself and in any exported CSV files.

HCO for DB2 LUW

Back to the list

• Help buttons previously available on the XDB Server Configuration Utility, XDB Service Controller,
Options Dialog, Bind Utility, and Linker Config (Link Profile) UIs have been removed with the exception
of error messages in the SQLWizard, Migrate, and Declaration Generator.
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Known Issues
Refer to the Known Issues and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

• Enterprise Server
• Resource Adapters
• REST/JSON IMTK implementation and the same-origin policy (SOP)

Enterprise Server

• On Windows 10, if you are using Microsoft's EDGE browser to access the Enterprise Server
Administration GUI, issues with EDGE can cause the automatic refresh feature to display a dialog
asking whether you want to resubmit a form. To work around this issue, cancel the resubmit request and
then refresh the server list page or the Home page of Enterprise Server Administration. You can also
turn off the automatic refresh by setting the Auto-refresh interval setting on the Home page of
Enterprise Server Administration to 0.

Resource Adapters

• Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may fail with a
ClassCastException. To work around this issue, you need to deploy mfcobol-xa.rar first, then need
to undeploy this file and deploy the local one, mfcobol-localtx.rar. If there are issues deploying
using the WebLogic GUI, you can use the command line. If there are issues with this as well, try
reducing the length of the command (for example, by moving the file to a location with a shorter path).

REST/JSON IMTK implementation and the same-origin policy (SOP)

• HTTP requests sent from scripts within a web browser to REST services deployed on an enterprise
server might fail due to the same-origin policy (SOP). Some browsers might implement (or support
plugins that implement) techniques for relaxing SOP such as cross-origin resource sharing (CORS) that
enable sending cross-origin requests successfully. For REST services, Enterprise Server does not
implement a method for relaxing SOP. This means that browsers that implement CORS (or any other
SOP relaxation technique) might still forbid requests made from scripts due to Enterprise Server not
implementing the equivalent technique on the server side.
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• Adis
• Assembler Support
• Character Animator
• CICS Support
• COBOL to XML Schema generation
• Codeset Support
• Common Communications Interface
• Communications Server
• Data Tools
• Documentation
• Embedded HTML Pre-Processor
• Enterprise Server
• File Handling
• HCO for DB2 LUW
• HCO for SQL Server
• IBM Language Environment for OS/390 & VM Support
• IMS Support
• JCL Support
• Mainframe Access
• Micro Focus Batch Scheduler Integration
• Micro Focus Directory Server
• Monitoring and Management
• OLE Class Library
• OpenSSL
• PL/I Support
• REX Support
• RM/COBOL
• Run-Time System
• SQL: COBSQL
• SQL: OpenESQL
• SQL Option for DB2
• XML Support

Adis

Back to the list

• PIC N items are now filled with double-byte space when required by ADISCTRL options 15 and 16.

2913183 (1108448)

Assembler Support

Back to the list
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• To provide EBCDIC to ASCII conversion, the Assembler directive ASCII has been added to generate all
character literals in ASCII instead of the default EBCDIC. For example: DC C'1' generates a hex 31
value instead of hex F1 when the ASCII directive is used.

2913358 (1108467)
• The copying of PDS files in Assembler is now supported. The assembler file handler now emulates

mainframe behaviour for opening/reading/writing/closing PDSs. This allows assembler programs to
open a PDS with these DCB settings: DCB=(DSORG=PO,RECFM=FB,LRECL=80,BLKSIZE=0) for both
input and output and copy a PDS with a simple read/write loop as on the mainframe.

2881923 (1108596)
• SVC 8 (LOAD) now sets the high order bit of the loaded module address as per the AMODE of the

loaded assembler module. If the module loaded has been linked AMODE(31) then the high order bit is
set in the returned address so it matches IBM mainframe behaviour.

2880278 (1107639)

CICS Support

Back to the list

• An issue causing a Communications Server failure during Cluster SEP recovery processing has been
fixed.

2883390 (1107785)
• A timeout on a global lock request for a CICS dataset, caused by the GLM not responding, could

generate an RTS 114 on dfh0msg in the requesting Cluster Slave.

2880992 (1107401)
• An issue with the _NOCONVERT option of CICS SEND FROM statements when a LU1 printer is used

as an output has been resolved. The control characters of the 3270 data stream are not meaningful to a
LU1 printer, and are no longer sent in such scenarios.

2877807 (1106961)
• Support has been added for the extended form of RECEIVE_ALLOCATE, "RECEIVE_ALLOCATE_EX",

to specify the alias of the local LU from which the TP will accept incoming attaches (IBM
Communication Manager only).

2877178 (1106980)
• A 64 bit CRTE or transaction routing request from IBM CICS mainframe to Micro Focus Enterprise

Server CICS now correctly returns the expected data.

2876499 (1106860)

• Programs that contain non-unique variables on a CICS command now produce a more specific error
message (COBEC1125 : Operand {operandName} is not unique) when compiled in an IDE.

2865273 (1105126)

• Terminating a SEP that is being waited on by another SEP no longer causes a corruption in the JCP/TD
return chain in the shared memory.

3107347 (1109532)
• An problem that caused a TASKIDERR to be returned on EXEC CICS INQUIRE TASK when the task

was greater than 9999999 has now been fixed.

3101286 (1109036)
• A problem has been fixed that caused INQUIRE Terminal to return TERMIDERR when the terminal had

been installed from a resource definition and the terminal did not have a termtype.

2912829 (1108576)
• A problem with the CASTSC system module crashing when a START with data was executed during

region initialization has been resolved.
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2886905 (1108257)
• An ASSIGN INVOKINGPROG in an XCTLed program now shows the correct program name.

2885264 (1108071)
• A problem that caused EXEC CICS SET FILE CLOSE statements to return an invalid request error

when the file was modified in the current task has been fixed.

2870461 (1106061)

• A problem with ESMAC display fields that enabled Authorization bypass and caused XSS-related issues
has been fixed.

3101205 (1108918)
• A problem in ESMAC that prevented TERM from accessing the related SYSC and SYS6 pages has

been fixed.

2881359 (1108307)
• The ESMAC > Clients page has been updated with a new Stop button that enables you to stop active

printers. In addition, you can now modify predefined printer terminal attributes and reinstall a printer
terminal.

2874807 (1106608)
• The Users button was sometimes unavailable in ESMAC. This has been fixed.

2860762 (1104487)

• CICS support has been updated to support the MQSUB API.

2878763 (1107270)

Character Animator

Back to the list

• The Break>Cancel-All option no longer occasionally freezes the Animator.

2879817 (1107460)

COBOL to XML Schema generation

Back to the list

• CBL2XML now handles namespace correctly.

2861655 (1104748)
• CBL2XML now correctly handles non-default type within <restriction>.

2826345 (1100279)

Codeset Support

Back to the list

• The Codeset DBCS tables MFTR0886.A2E MFTR0886.E2A have been updated to match the latest IBM
Traditional Chinese conversion tables below: Description of 9027: T-Ch Host Double-Byte including
6204 UDC including euro. Description of 21427: T-Ch DBCS-PC (IBM BIG-5) including 13493 CNS, 566
IBM selected, 6204 UDC & euro.

3104948 (1109314)

Common Communications Interface

Back to the list
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• Using CCI shared memory and receiving data with a max receive length less than the total amount of
data received resulted in the data being received incorrectly on the final receive. This has now been
fixed.

• After a communications failure, Enterprise Server shared-memory listeners would sometimes stop
accepting new connections. This has now been fixed.

Communications Server

Back to the list

• A path-traversal vulnerability has been fixed in the mfcs-esfadmin optional component of Enterprise
Server. This vulnerability could allow a user with network access to a suitably-configured Enterprise
Server region to download unauthorized files from the target system.

3101205 (1108925)
• In Enterprise Server, chunked HTTP requests now work with CICS Web Interface and CICS Web

Services servers.

3100279 (1108857)
• Persistent J2EE sessions to Enterprise Server could hang under heavy load, resulting in accumulating

idle transient SEP processes. This has been fixed.

2884386 (1108206)
• Enterprise Server's communications server (MFCS) no longer crashes in certain error-handling

situations, such as when sufficient memory cannot be allocated to handle an extremely large HTTP
response message.

2881711 (1107546)
• Enterprise Server now correctly enforces the order of responses to each client.

2874420 (1107167)
• An issue causing intermittent MFCS crashes at start-up due to heap corruption has been fixed.

2866204 (1105983)
• TN3270 conversations no longer hang, looping in the MFCS process, if the client sends a malformed

TN3270E header. A message will now be written to the MFCS log and the input record will be
discarded.

• An error handling bug in the MFCS Fileshare connector, which could cause a thread-termination error,
has been fixed.

• In some cases, MFCS could hang or crash some time after multiple threads abended within a 60-
second period. This has been corrected.

• HTTP path-traversal vulnerabilities, which could lead to information exposure, have been corrected in
Enterprise Server's MFCS component.

Data Tools

Back to the list

• Vision and RM files that contain a null (0x00) byte in the key now function correctly in the Data File
Editor.

2882159 (1107598)

• The following minor enhancements have been made to the Data File Editor: - Previous filter conditions
are now remembered for each file when the dialog is loaded. - The default filter operator now defaults to
'Contains'. - Field attributes for reference conditions now default to 1:max-rec- length, instead of 1:1.

2878521 (1107104)

Documentation

Back to the list
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• The product documentation has been updated to include information and syntax for secure access to
MFDS (mfds /b).

2854625 (1103606)
• Documentation for environment variables has been improved.
• The product documentation has been updated to include the MFA_INDEX_FORMAT environment

variable used in configuring the Enterprise Server.

2278928 (1066511)

• The casstart /w parameter prevents the casstart process from exiting until the region has either started
or failed to start correctly.

2868898 (1105712)

• A "redundant" or "high-availability" mode is now available in the Enterprise Server External Security
Facility. It enables you to configure multiple equivalent Security Managers and let processing continue
as long as at least one Security Manager is available. To enable this feature, add the following to the
configuration text area for the security configuration (either in the default Enterprise Server Security, the
MFDS Security, or on the Security tab for a specific enterprise server): [Operation] redundant=yes

2989911 (1108665)
• The Enterprise Server documentation no longer includes the PL/I programming guide as it includes

information about editing, compiling and debugging PL/I programs which are not under in Enterprise
Server.

2877789 (1107019)
• Additional information on the Web Services and J2EE conversation type has been added to the

"Configuring Listener Conversation Types" chapter in the product documentation.

2877270 (1106896)
• The product documentation has been updated to include information on converting the input file used by

casrdtup from EBCIDIC to ASCI.

2863611 (1104940)
• The documentation for bit zero of the 'thread-state' parameter of CBL_THREAD_LIST_START and

CBL_THREAD_LIST_NEXT has been corrected.
• Documentation of CBL_LOCATE_FILE parameter corrected.

• The installation instructions included incorrect information about users having to stop and uninstall an
existing Micro Focus Directory Server (MFDS) or CCITCP2 Windows service (on Windows) or a
process (on UNIX) from an existing product. This has been removed from the product help.

2877431 (1106934)

Enterprise Server

Back to the list

• An issue where SOAP elements were not mapped to COBOL code has been resolved.

3106199 (1109416)
• When SOAP headers were part of the SOAP request, you no longer receive a "SOAP header

malformed" response.

3105803 (1109367)
• An issue where a handler program in the pipeline caused issues with JSON GET/DELETE/HEAD

requests has been fixed.

3104977 (1109274)
• An UNDEFINED_ELEMENT error message occurred when a JSON message (under CICS WEB

SERVICES) did not include an object that was present as a "record 1" item in the wsbind or the jsbind
files.
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3102943 (1109085)
• When a CICS Web Service was invoked with no port in the URI, the default port for the scheme was not

set up.

3100280 (1108870)
• EXEC CICS SEND and CONVERSE commands now send all user-written headers (EXEC CICS

WRITE HTTPHEADER) even if the user provided values that contain null bytes. When browsing
headers with EXEC CICS WEB READNEXT HTTPHEADER, CICS will now initialize the buffers that
were supplied for the header name and value.

2990561 (1108733)
• A problem where a system process (CASTRC) was unable to allocate any local storage and, as a

result, became unresponsive, has been resolved.

2886741 (1108236)
• Casout commands running in a loop from the same process used to exhausting resources. This was

caused by an invalid path concatenation.

2886407 (1108426)
• An issue resulting in a Run-Time System error 205 "Invalid mainframe pointer" has been fixed.

2885280 (1108041)
• TRANSFORM was failing in situations where an XMLTODATA TRANSFORM contained an XML

declaration with EBCDIC encoding.

2885262 (1108040)
• The EZASOKET traces are now controlled by a COMMS trace flag.

2884491 (1108174)
• Caching has been added for TS queues security checks.

2884070 (1108789)
• Commarea overrides are now honored for non-facility transactions.

2884049 (1107879)
• Usernamelen and passwordlen options are not mandatory on exec cics web converse and web send

(client).

2880669 (1107365)
• Previously, using multiple CICS LINK statements (linking A to B to C and so on) could result in an RTS

error 114 in the CAS system modules.

2880542 (1107372)
• The spool active job queue will now display any jobs that were started prior to resetting the time for DST

but that have not completed yet.

2879116 (1107204)
• The debug file name generated when using CICS Web Services now includes the process ID and the

task number. For example - inquireCatalogClient-19556(00028)-CWS-REQUESTER.TXT.

2878485 (1107077)
• The SOAP to COBOL mapping under CICS Web services was incorrect when an optional element had

no child elements (where the schema defined a minimum of one such child element and these child
elements have been mapped to a container). In such cases, the number of instances of the child
element would have an incorrect value of 1 where it should be 0.

2877043 (1106879)
• If you used XA with more than 7281 transactions or had a number of JCL jobs that used XA, a record

could be split across multiple blocks. After restarting the enterprise server, a large number of
CASXO0029I errors were reported in the console log file. A block that can hold up to 7282 records is
now used.

2874024 (1106469)
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• When casout is used to release a job, casmgr now attempts to dispatch the job immediately rather than
waiting for its next dispatch cycle which previously could take 20 seconds.

2873224 (1106621)
• If there were more than 20 TRANCLASS instances specified in the startup list, this could cause

memory corruption.

2868129 (1105682)
• The ESFCA0401I Cache Termination message is now available for JES, IMS DB, IMS TM, MQ, and

iFileshare processes.

2866750 (1105376)
• A duplicate security check about whether the user has enough permissions to run a JCL job has been

removed.

2866526 (1105336)
• When eci-tpn is used on a call to ECI for CTG or the Micro Focus implementation of ECI, Enterprise

Server now verifies the transaction exist and is enabled. If the transaction is disabled, an abend AZI6 is
returned. This is mainframe-compatible behavior.

2863500 (1105165)
• An EXEC CICS LINK to a non-CICS module now handles the data context correctly and you no longer

receive CDCD abends on any further LINKs.

2858747 (1104275)
• CASxx5006I messages now display a return code.

2853609 (1103516)
• All ESMAC pages are now secured. Users who are not authorized now receive an error message when

trying to access any of these pages in their browser.

2843901 (1102247)
• The CICS WEB services now support SOAP 1.2.

2822822 (1099723)
• An issue that could cause an RTS error 119 on a casout command when starting a batch initiator has

been fixed.

• An issue with certain length DNs that could cause DNs to become truncated has now been fixed.

3103303 (1109366)
• If nested groups (user groups containing other groups) were used with LDAP-based security for

Enterprise Server, it could result in Enterprise Server hanging at region startup, or users might not be
assigned all of their groups. This has now been fixed.

2988205 (1108935)
• The "check TLQ first" option has been added to the MLDAP ESM. The option can change the Rule

processing algorithm. This option might improve performance when there are large numbers of
resources in a class.

2875051 (1106874)
• Enterprise Server no longer crashes on startup if LDAP-based external security with the "all-groups"

and "redundant" options are both specified, but the "federated groups" option is not.

2874010 (1106529)
• If the esfupdate utility is used to request an update of security information for a user, and that user was

originally signed onto the system using a lowercase representation of their user ID, the update now
correctly identifies and updates the user.

2871297 (1106164)
• If the MFDS Security Configuration specifies that verify requests should be cached and the cache TTL

and limit values are non-zero, for example, the MF Directory Server Security configuration page
Security Facility configuration text contains: [Cache] requests=verify If a new password was specified in
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a Web interface logon request, then previously it was being ignored. Previously, if the user was logging
on with an expired password and attempting to change the password the request would also be ignored
and an expired password error would be returned.

2868342 (1105626)

• An RTS 205 error during the execution of an AMODE application could occur when Assembler address
0 was erroneously de-registered. This is now fixed.

3104561 (1109229)

• Under heavy loads, the ESFCA0401I log messages were not appearing at the correct intervals.

2863222 (1104948)

• Enterprise Server listeners that are configured for TLS (also known as SSL) no longer hang if a client
connects to them without sending any data.

2873177 (1106408)
• In some HotFix releases of earlier versions of Enterprise Developer and Enterprise Server, SSL or TLS

connections to an Enterprise Server could hang if client certificates were used and there was a delay of
at least several seconds before the certificate was sent.

Embedded HTML Pre-Processor

Back to the list

• The XML run-time system did not handle data items with the OCCURS clause correctly.

3107418 (1109566)

File Handling

Back to the list

• The ESF LDAP Security Administration Web Interface now has a logoff button.

2871551 (1106117)
• CICS SYSOUT output now displaying correctly in the Classic Data Tools editor. Some recent changes

to determine whether or not in-stream data needed to be converted to/from EBCDIC were causing the
problem.

2883885 (1107847)
• If data compression is specified when trying to open a fixed block file, when running under a mainframe

dialect, the File Handler now checks to see if it is trying to open a VB file. If it isn't, compression will be
turned off and the file will be opened as normal.

2870022 (1105956)
• An internal field used to store the current file status was being overwritten by the allocation of a buffer.

Now we store it off beforehand so its value can be restored, and an accurate file status returned.

2868664 (1105707)
• When certain in-flight rewritten records were rolled back at the end of a transaction, the File Handler

was setting incorrect values for the length field in some records and various warning messages were
displayed during index file validation.

2864802 (1106106)

• A CBL_FREE_MEM statement in Fileshare was missing a 'by value' clause, which was causing a run-
time error. This is now fixed.

2883421 (1107767)
• When running under Fileshare, a delete on a locked record no longer results in a record locked status if

the same user had previously obtained a read lock on the file.
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2832909 (1108287)

• When REBUILDing from SEQ into IND with duplicate key, you will no longer get a corrupted file if you
do not specify the target flag /t.

2880311 (1107302)

• CSF to ZD negative sign conversion is now handled correctly during a sort operation.

3103118 (1109125)
• JCL SORT no longer abends if no record is rewritten to a DUMMY data set.

3102468 (1109052)
• Sorting ESDS files to RRDS files no longer truncates the first 4 bytes of each record.

3101385 (1109112)
• Variable length SORT OUTFIL files are now created correctly when more than one data set is specified

in the targeted OUTFIL.

2881629 (1107551)
• MFSORT INCLUDE will no longer include the first record in the concatenated file if, according to the

parameters, that record should be excluded; previously, the first record was included regardless of the
parameters.

2876259 (1106785)
• For an MFJSORT, a combination of numeric tests and logical comparisons now returns the correct

records.

2870986 (1106216)
• When copying concatenated files in MFJSORT, for sequential fixed block, the correct number of record

is now used.

2870506 (1106057)
• MFJSort now produces the correct number of records regardless of the value of the SORTSPACE

setting.

2867668 (1105534)
• An error when writing the ICETOOL listing from an empty input file has been corrected.

2866176 (1106459)

HCO for DB2 LUW

Back to the list

• The HCO DCLGEN tool has been updated to generate PL/I copybooks with valid definitions for graphic
and decimal data types and to compile cleanly with the PL/I -mvs option.

3105260 (1109306)
• A problem that sometimes occurred when using the DB2(NOHCO) compiler directive option caused the

return of incorrect codes at completion of program execution. This has been fixed.

3100172 (1108872)
• The DB2 preprocessor has been updated with a new DB2 compiler directive option, QUALIFY-CALL,

that works with the QUALIFIER compiler directive option to qualify DB2 EXEC SQL CALL statements
with the schema name specified by the DB2 QUALIFIER directive.

2884948 (1108032)
• The DB2 ECM has been updated to prevent an undefined ECM error when indicator variable arrays are

used in SELECT SQL statements.

2884605 (1107947)
• The DB2 ECM preprocessor has been updated to support host variables defined as SQL TYPE IS XML

AS BLOB-FILE/CLOB-FILE/DBCLOB-FILE.
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2839654 (1101707)

HCO for SQL Server

Back to the list

• HCOSS handling of the DB2 CHAR scalar function has been enhanced for date and time conversions.

3103159 (1109143)
• The OpenESQL preprocessor has been updated to reorder certain SQL compiler directive options to

prevent the generation of a COBES0121S error.

2883191 (1107806)

IBM Language Environment for OS/390 & VM Support

Back to the list

• The Language Environment (LE) utilities are now available for managed COBOL applications in both
ILGEN and ILVERIFY formats.

2843311 (1102161)

IMS Support

Back to the list

• Erroneous file status 46 messages appearing on the Enterprise Server system console have now been
fixed.

2886926 (1108578)
• An IMS syncpoint failure that intermittently occurred at job termination, depending on the timing of

events, has now been fixed.

2877595 (1107134)
• This RPI described the situation where a "GU" call using a pcb with the PROCSEQ option on a

secondary index was incorrectly returning the primary key, not the secondary index, in the pcb key
feedback area. This fix returns the secondary key or index in the key feedback area.

2877248 (1106941)
• A new warning message has been added to indicate when a checkpoint call is delayed due to a

duplicate checkpoint ID. In addition, the ES_IMS_BASIC_CHKP_OPT environment variable has been
added to provide additional checkpoint optimization that enables a basic checkpoint call to process as if
a SYNC call had been issued.

2875685 (1107227)
• IMSLOGR file access errors that sometimes occurred on the IMSLOGR.DAT checkpoint log file when

two or more IMS BMP applications shared the file have been fixed.

2872783 (1106751)
• A batch IMS program that terminates abnormally now flushes subsequent job steps in the JCL.

2864940 (1105315)
• An RTS114 message was sometimes issued during the CASDBC process on a system running under a

heavy IMS DB load. This has been fixed.

2860205 (1106684)
• The Start and Stop DB commands failed to reject non-existent DBs.

2857756 (1104092)
• A problem with the behavior of an EXEC DLI application accessing a USERDB exit has been fixed.

2849576 (1102989)
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• A problem that prevented IMS from making the connection to the DB2 subsystem via DSNALI when
JCL is running the DNSMTV01 program, in batch mode has been fixed.

2846683 (1102634)

• The MFS generator has been updated to issue an error message when adjacent output screen fields
are not separated by a space. To correct the problem, edit the MFS source to include a space between
the fields.

3101284 (1109215)
• A new MFS compiler directive, CONTMVS, has been added to enable the compiler to parse imperfect

MFS continuation lines just as on the mainframe, meaning that when it encounters a line in the MFS
source that is continued without a terminating comma, it treats the line that follows as a comment line.
When CONTMVS is not specified, terminating commas are assumed, and the next line is treated as a
continuation of that line.

3101284 (1108961)
• The MFS generator has been updated to generate the extended color attribute only when specified in

the MFS source, enabling the default colors in the PCOMM 3270 emulator to take precedence.
Regenerate MFS source after adding the extended color attribute.

2887354 (1108314)
• The SYSMSG field was right-justified and this was causing a problem with displaying the output format.

The output format is now displayed correctly.

2885315 (1108134)
• The printed report page is now padded with blank lines if the number of lines is less than the number of

lines per page specified in the MFS source. This only applies if the PAGE parameter is
PAGE=(n,SPACES).

2885281 (1108042)
• An error message is now sent to the terminal if the input consists of null segments.

2882071 (1107587)
• High-value (x'FF') bytes are no longer incorrectly removed from inbound TN3270 client data.

2880275 (1107581)
• The trancode was being stored in a screen device field with non-modifiable extended attributes. When

resending the output screen (write command), the MDT was not being set. Input of the trancode was
not being transmitted, resulting in a DEST NOT FOUND message. To implement the fix, you must
regenerate the MFS.

2876099 (1106859)

• The IMS preprocessor has been updated to determine whether a job is a normal start or a restart by
looking only at the first five bytes of the checkpoint ID, as is done on the mainframe, ignoring additional
bytes if the first five are spaces. In addition, when a checkpoint ID is determined to be invalid, the
EBCDIC value of the ID is converted to ASCII before writing it to the job log.

3107216 (1109583)
• An RTS 173 occurred at end of a job when an MQ entry point call at the end of step to clean up was

unloaded by canceling the MQ modules. This has now been fixed.

2872962 (1106368)
• DLI status codes FD (deadlock loser) and BD (lock timeout) returned to a CICS application did not

ABEND as they should have. These status codes now properly trigger an ADCD transaction ABEND.

2864939 (1105080)

• The IMS-TM "Trailing space" property was ineffective for EBCDIC transactions. This has been fixed.

2880919 (1107479)
• A problem when connecting to an IMS printer that caused all pending print jobs to fail has been fixed.
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2879885 (1107242)
• When the last DLI call was a CHKP call, IMS incorrectly issued a COMMIT rather than a ROLLBACK

sync point during an ABEND of an IMS BMP. This has been fixed.

2877795 (1107323)
• A problem that caused an External Security Manager to indiscriminately authorize an unprotected IMS

resource without regard to its "allow unknown resources" configuration setting has been fixed.

2877057 (1106882)
• A problem with incorrectly formatted output data appearing on IMS screens when default literals or

system literals were assigned to output message fields has been fixed.

2825068 (1100049)

JCL Support

Back to the list

• Spool files with a status of 'Printing' are now correctly removed from ESMAC when housekeeping is run.

3108694 (1109666)
• An issue with the Catalog having an incorrect GDG current bias has been fixed.

3106790 (1109468)
• Specifying DD Dummy in front of the DSN now results in the same behavior as on the mainframe.

3106305 (1109425)
• A catalog listing of a dynamic PDS, where the PO is defined in a user catalog, will now return the

correct list of members.

3106260 (1109433)
• Specifying DD Dummy in front of the DSN now results in the same behavior as it does on the

Mainframe.

3104175 (1109272)
• JCL HSF - if a job step abends because a data set was not found, the resp field of the previous record

will no longer be corrupted.

3103184 (1109101)
• A new environment variable has been introduced. Set ES_JES_PARM_INIT_LOW=Y to initialize the

parameter string passed to a program executed by JCL to low-values. The default behavior
(ES_JES_PARM_INIT=N) is to initialize the string to spaces.

3100700 (1109519)
• A deadlock situation, when multiple dispositions were used for the same file, has been fixed.

3100475 (1109067)
• MFJPTPCH now returns a condition code of 4 when it is run against an empty file.

2991029 (1108802)
• A fault in the final disposition processing of a MOD,PASS dataset has been corrected.

2990557 (1108750)
• An issue with the Catalog having the incorrect GDG current bias when concurrent jobs access the same

GDG, has been fixed.

2990054 (1108690)
• An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been

fixed.

2988755 (1108562)
• An enhancement to the loading of a JCL program means that, if there is a problem loading it, the run-

time system error code will be reported. The JCLCM0193U message, PROGRAM NOT FOUND -
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<program name>' has been changed to 'PROGRAM NOT LOADED - <program name>. RTS CODE:
<rts code>'.

2988302 (1108519)
• MVSSPLHK now correctly removes the JESYSMSG for the last job in casspool.dat.

2886034 (1108308)
• A new option (CLEAN-DS-FROM-ACTIVE) has been introduced to the MVSSPLHK spool housekeeping

process, which prevents removal of time-expired datasets from an active job.

2885734 (1108144)
• MFFTP now correctly updates the sftp.cfg file with the port number specified in the JCL PARM.

2885618 (1108295)
• The detection of the charset of command files used by MFFTP has been improved.

2885559 (1108081)
• The failure of MFFTP to transfer an empty ESDS file from a user defined file has been corrected.

2883862 (1107878)
• The delete sweep processing of GDG has been corrected so that a new GDG dataset created in a step

is not reported as 'dataset not found' in successive steps when its older generations are deleted via
DISP=(OLD,DELETE).

2883681 (1107850)
• When using IDCAMS ALTER NEWNAME for a GDG bias, a check is performed to ensure the GDG is

defined in the catalog, and if it isn't, an error message (JCLAM0241E) is generated.

2881259 (1107477)
• The ASC2EBC and EBC2ASC modules are now included in the MFFTP module.

2880401 (1107321)
• A file not found error resulted when using a PDSM for SYSUT1 in an MFJPTPCH step. This has now

been fixed.

2879536 (1107203)
• An RTS114 error in IDAMJRM, when using MFFTP, has been corrected.

2879453 (1107607)
• An issue where duplicate job numbers were assigned if MF_MVSJOB had a reset value of '+' has been

fixed.

2875286 (1106770)
• Adding a new dataset no longer results an error in the ESMAC catalog listing (error code 9904).

2874557 (1106582)
• When a JCL process was forcibly killed, an ENQ on SYSZJOBD could be left preventing other jobs of

the same name from running.

2872077 (1106506)
• Previously, setting a BLKSIZE of zero resulted in a catalog entry with a BLKSIZE set to 65535.

2871795 (1106303)
• An issue when using MFFTP to transfer a file that has consecutive CRLFs has been corrected.

2870653 (1106015)
• You no longer receive a U4038 abend when calling MFJZLPSA with a JCL that uses DFSRRC00 and

BMP.

2869477 (1105804)
• An RTS114 error in IDAMJRM, when renaming a dynamically allocated GDG bias using MFJCTLBP,

has been corrected.

2868312 (1105647)
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• An issue with tracing messages from MVSSPLHK could result in receiving an RTS 114 error message.

2867854 (1106300)
• A problem that sometimes caused IEBCOMPR\MFJMATCH results to be truncated has been fixed.

2867057 (1105644)
• The catalog xml utility, mfcatxml, now supports the export and import of VSAM-SHARE-OPTS using the

GDG-EMPTY-COUNT field.

2866823 (1105394)
• Under VSE, when the environment variable ES_SAM_ESDS is set to Y, an open OUTPUT of a reusable

ESDS file resets the file in situations when the DISP is not specified in the DLBL statement.

2865599 (1105186)
• The catalog list function now returns correct results when user catalogs exist.

2865225 (1105120)
• When using the JOB KEEP option of MVSSPLHK without a duration parameter, the job was removed.

2864643 (1105034)
• The JES000915E error message now shows the correct userid.

2856571 (1103927)
• Some issues with the performance of MFJAMS LISTCAT processing have been fixed.

2809335 (1105962)
• The number of supported user catalog nodes, MFUSERCAT_NODE and MFUSERCAT_LOC, has been

increased to 64.

2805554 (1106346)
• If you have enabled 7-digit job number support via MF_MVSJOB, to revert to 5-digit support, set

MF_MVSJOB=<low number>+<high number> where high number is less than 0099999, and ensure
that the '+' sign is used to separate the low and high values.

• You can now make catalog searching and filtering more consistent with the results produced on the
mainframe by setting ES_CATLG_DISABLE_ADDITIONAL_QUAL=Y. Setting this variable to Y emulates
the effect of disabling the ‘Include Additional Qualifiers' option on the mainframe. The default setting for
ES_CATLG_DISABLE_ADDITIONAL_QUAL is N.

2883777 (1107870)
• Trying to delete a job record no longer fails with a Run-Time System error 173.

2876102 (1106778)
• ES_ESM_IGNORE_PDSM_RULE must be set to 'Y' to ensure that the access to PDS members in

ESMAC is controlled by the access privileges to the PDS itself.

2869207 (1105872)
• The support for catalog listings using wildcards has been improved.

2860297 (1104531)
• Using the JOB field (and then Delete) to delete all SYSOUTs of a job now works as expected.

2857238 (1104017)

• Conditional execution of the MFPAUSE user exit is enabled if the PAUSE statement follows an IF
statement.

2869354 (1105809)
• DLBLs in the VSE configuration file are now allocated correctly when the JCL contains a PAUSE

statement.

2867871 (1105749)
• A problem with MFFTP that prevented the FTP of an empty ESDS file has been fixed.

2867363 (1106130)
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• To prevent interference with MFFTP execution when running under VSE, edit the VSE configuration file
USE-SYSIN section for MFFTP and assign the permenant instream DD name to SYSIPT (IPTSYS).

2864865 (1105434)
• Jobname information is no longer carried forward from one VSE job to the successive jobs.

2864594 (1105072)

Mainframe Access

Back to the list

• The "$" and other national characters are now included in Endevor member filters.

3103132 (1109163)
• A z9 compatible version of MFA is available on request from your Support Engineer or Account

Manager.

2885220 (1108073)
• You no longer need to use the MFA4ENDV LRECL override table when using Endevor types with a

source length greater than 80.

2878450 (1107406)
• After an MFDAS IMPORT failed with an open error on a data set the associated file handle was not

freed. This could potentially lead to the depletion of all MFA file handles.

2878272 (1107023)
• Line sequential output is now correctly handled by the MFA file handler (Data Connect).

2878168 (1107430)
• Mainframe Access server provides a new command, UNLOCK, with the following syntax: F

MFA,UNLOCK,DSN=aaa.bbb[,MEM=mmmmmmmm] You can use this command in situations where a
user has terminated an AWM edit session which left the member lock active. To display MFA ENQs, use
IBM's TASID (option 3) application from ISPF. This application provides a much better display than the
console display.

2860316 (1104416)

• Customers using non-US code pages no longer receive errors when doing bulk member import with
mfmonmx2.

2881013 (1107577)
• The mfmon2 utility now only performs an initial download if the Micro Focus PDS does not have any

ISPF statistics.

2872024 (1106302)

• Previously, for catalog filters specified in "mfdas cat ..." commands, the character '#' was translated to
'%', which is interpreted as match any character. Since '#' is actually a valid alphabetic character in US
EBCDIC and can be used in data set names, this behavior caused unexpected problems with catalog
services. This feature has now been deprecated.

2877352 (1107173)

Micro Focus Batch Scheduler Integration

Back to the list

• MFBSIJCL now returns the return-code 219 when the batch SEP is killed.

2881528 (1107507)
• MFBSI now writes back the Control-M %%INCLIB statement in the submitted JCL. This is to help

identify the origin of JCL statements.

2868077 (1105595)
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• The MFBSI Control-M AutoEdit emulation is now ignoring the IF/ELSE statements block when the
condition is false.

2863481 (1104860)
• The default delays used by MFBSIJCL to check for a job state in Enterprise Server are as follows - two

seconds before each check for "Job Started" and ten seconds before each check for "Job Concluded". It
is now possible to configure these delays in the MFBSI configuration file, mfbsi.cfg, with the following
two new parameters - JOBSTART-LOOKUP-FREQ and JOBEND-LOOKUP-FREQ. Both parameters
accept values between 1 and 60 (in seconds), and AUTO. When AUTO is used, MFBSIJCL uses an
initial frequency of one second for three minutes after which the default values are restored. Using these
parameters will significantly reduce the overhead elapsed time in MFBSIJCL when compared to the
Enterprise Server JCL reported execution time of a job. This has an effect mainly in scenarios when you
have short-running jobs that are frequently executed.

2857416 (1105116)
• MFBSI now resolves the Control-M statements %%INCLIB and %%LIBSYM using the DSN located in a

user-defined Catalog.

Micro Focus Directory Server

Back to the list

• Fixed a memory leak in the MFDS process.

2876419 (1106799)
• A memory leak in the MFDS process occurred if non-SSL-enabled connection attempts were made

against an SSL-enabled MFDS. This has now been fixed.

2869493 (1106567)
• The MFDS -g command-line option now correctly handles the import of multiple region definitions from

a single XML file.

2840162 (1101798)
• An issue that could potentially cause heap corruption in MFDS if the configuration data for an individual

object was greater than 1K has been fixed.
• The "Renew" option available in the Enterprise Server Administration Web interface now works if SSL is

enabled.

Monitoring and Management

Back to the list

• JCL jobs that generate STEPBYPASSED events no longer cause incorrect values in JCL HSF records.

2886646 (1108200)
• Spurious STEP BYPASSED events for dummy steps were being passed to the user exit and the HSF

exit.

2873504 (1106446)
• An issue where duplicate HSF records could be created has been fixed.

2856941 (1103977)

OLE Class Library

Back to the list

• A problem with accelerator keys being handled by an ActiveX control has been fixed.

2990224 (1108719)
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OpenSSL

Back to the list

• The version of OpenSSL included in this product has been updated to version 1.0.2j.

PL/I Support

Back to the list

• MOD function now works correctly with char string arguments.

2880086 (1107327)
• Using RETURN inside a SELECT now works correctly.

2877979 (1107006)
• A problem when using SUBSTR as an argument to UPPERCASE has been fixed.

2863064 (1104802)

• A problem invoking a function call using an entry variable with the unaligned attribute (or compiled -zp1)
has been fixed.

3107510 (1109544)
• Diagnostic message 2012 has been changed as follows: Internal IL overflow. Unable to continue

processing. Try breaking the compilation unit apart into smaller modules if possible, or reducing the
number of executable statements. If this message persists, contact Micro Focus SupportLine.

3106231 (1109494)
• mfplx32 and mfplx64 will now always compile in correct mode.

3105182 (1109296)
• A problem calling a function with no arguments and a fixed decimal return type with non-zero scale has

been fixed. This problem was limited to calling the function without (), e.g., call func;

3104790 (1109255)
• A problem with restricted expression evaluation of initializers when the GLOBALDEF attribute is

specified has been fixed.

3104276 (1109288)
• A problem when passing structure arguments to structure parameter descriptors that was not of the

same shape is now properly diagnosed.

2991300 (1108810)
• Passing duplicate string literals as function parameters now works correctly when compiled using -opt.

2991006 (1108785)
• A problem when using both the compiler options -graphic and -fdmaxp has been fixed.

2990363 (1108706)
• A problem with an assignment of a non-array structure to array of structure has been fixed.

2912429 (1108422)
• A problem diagnosing an expression used as data-list item has been corrected.

2883992 (1107886)
• Using TRIM as a parameter to another built-in function now works correctly.

2882983 (1107722)
• A problem with array structure assignment requiring conversion has been fixed.

2882731 (1107654)
• Assigning ''G to a graphic variable now works correctly.

2881762 (1107513)
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• The compiler now diagnoses possibly uninitialized automatic variables at the point of first use as seen in
the source program, if not previously set by an assignment statement, or passed-by-reference as an
argument in a procedure call.

2881037 (1107420)
• ENTRY with the LIMITED attribute is now supported. Restriction: ENTRY LIMITED with STATIC INITIAL

is not currently supported (AIX only).

2881035 (1107482)
• The STRING built-in function has an implementation limitation of its result length of up to 32767 bytes.

The compiler now diagnoses this limitation for a non-variable length result with an S-level diagnostic.

2880813 (1107384)
• mfpli no longer loops endlessly when compiling some programs with the -pic option.

2878919 (1107206)
• An erroneous diagnostic citing an invalid DEFINED overlay has been corrected.

2871953 (1106212)
• An issue with GRAPHIC string comparisons has been fixed.

2869451 (1105800)
• A problem with initialization of structures containing a CHAR(0) member has been fixed.

2868923 (1105719)
• A problem with passing an unconnected array reference to an argument with CONNECTED in its

descriptor has been fixed.

2868606 (1105886)
• A new compiler option "-default connected" (or "-dft conn") applies the CONNECTED attribute to array

parameter descriptors by default. When passing arguments to parameters without an explicit
CONNECTED attribute, the compiler assumes the callee parameter to be connected. If the caller
argument is unconnected (discontinuous in memory), a dummy connected argument is created at the
call-point. The NONCONNECTED attribute when explicitly applied to parameter descriptors overrides "-
default connected".

2868606 (1106271)
• The compiler now diagnoses PICTURE specifications which cause internal compiler implementation

limits to be exceeded.

2868176 (1105602)
• A problem with GRAPHIC concatenation causing a SIGSEGV has been fixed.

2867892 (1105565)
• Repeat factors for PIC X and PIC A specifications are now allowed up to 255. The maximum total field

width of a picture specification remains at 255 bytes, now documented under Implementation Limits in
the Open PL/I User's Guide.

2867770 (1105548)
• A problem with an ENTRY invocation without () has been fixed.

2867705 (1105540)
• A problem with a comparison of a BIT(1) to a numeric literal or FIXED BINARY variable has been fixed.

2866657 (1105363)
• A possible problem with the scoping of implicit and contextual declarations has been corrected.

2865207 (1105109)
• The diagnostic message MFPLI00176S when issued erroneously has been fixed. The text of the

diagnostic has also been corrected and changed to W-level.

2864859 (1105066)
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• A problem with EBCDIC conversion of string literals under the Japanese locale has been corrected.

2859505 (1104311)
• A problem calling entry variables based on pointers has been fixed.

2840869 (1101873)
• The CHARVAL built-in is now supported.

(627778)
• The relational operator <> is now supported. It is equivalent to "Not Equals".

(625262)

• Previously, if the user had set TMP, TEMP, or MFPLI_CONFIG_DIR to a non-existent directory and
attempted to debug a JCL Jobstream using CodeWatch, the job was wrongly terminated. A new CTF
diagnostic is now generated which will allow the user to determine that they've incorrectly set the
directory to be used for temporary files.

2882313 (1108052)

• Previously, a diagnostic was issued if a macro variable was declared twice. It is now only issued if the
second or subsequent declaration has different attributes from the initial declaration.

3108673 (1109680)
• Previously, if a nested macro was invoked using a parameter that had been omitted, but which had a

value assigned in the enclosing macro, the nested macro did not receive the parameter value.

3105212 (1109323)
• Previously, the macro preprocessor issued a syntax error when a macro preprocessor variable was

declared using the SCAN or NOSCAN attributes.

3104598 (1109315)
• Previously, if the ANSWER statement was used in a PL/I Macro, the resulting output was not rescanned

for replacement prior to being driven to disk.

2887974 (1108455)
• Previously, if using the PL/I Macro Preprocessor to handle code which contained IBM's newest operator

"<>" for "Not Equal", an error message was generated. The Macro Preprocessor has been enhanced to
accept <> as not equal.

2885570 (1108085)
• A previous fix related to the use of -margins and PL/I exponentiation caused a failure when a macro

expanded and caused a comment to be pushed to straddle the right margin such that the / and * were
split. This no longer occurs.

2884503 (1107984)
• Previously, if a % preprocessor statement was on the first valid column of a line which preceded a line

which ended using all available columns and -margins was specified, then the data on the preceding
line could be erroneously omitted. This no longer occurs.

2884467 (1107970)
• Previously, if declaring macro preprocessor arrays within a factored declaration, they were not correctly

parsed/interpreted. This has now been fixed.

2880399 (1107344)
• Previously, if using RETURN; within a PL/I Macro, it was flagged as invalid syntax. This no longer

occurs.

2880397 (1107334)
• The PL/I macro preprocessor now accepts the "_" character in hex literal constants.

2880350 (1107312)
• The macro preprocessor now supports macro procedures written with a void parameter list.
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2880349 (1107311)
• Previously, the use of open and close parens within the ANSWER expression caused an incorrect result

and/or an error message. This no longer occurs.

2880347 (1107314)
• An enhancement made to support -incafter in a single macro pass broke the macro preprocessor's

ability to use macro pp built-in functions outside of a macro pp procedure. This has been fixed.

2877724 (1106992)
• Previously, the macro preprocessor did not support the LEAVE statement for exiting a DO block. It is

now supported.

2874544 (1106595)
• Previously, the macro preprocessor did not interpret a DO statement with "BY 0" as an infinite loop that

could only be terminated by a LEAVE or GOTO. This has now been fixed.

2874169 (1106508)
• Previously, the macro preprocessor required the first token in a THEN or ELSE clause of an IF

statement to be a % symbol when parsing outside of a macro procedure. This is no longer required.

(627710)
• Previously, %PROCESS statements in the code resulted in an error when the code was parsed by the

macro preprocessor. %PROCESS is now parsed/ignored.

(628209)

• Previously, a CTLASA file that was opened for output but not written to erroneously generated a
CTLASA Page Feed when closed automatically. This has now been fixed.

3105667 (1109464)
• Previously, if an AREA variable was part of a structure, and the structure was BASED, AUTOMATIC or

CONTROLLED storage then the AREA was not usable until it was initialized with the EMPTY built-in
function. Enterprise Developer now mimic IBM's behavior and automatically initialize AREA variables to
EMPTY() regardless of whether they are scalar or part of a structure.

3104275 (1109498)
• Previously, a combination of consecutive PUT SKIP() statements did not generate a series of CTLASA

characters that matched the IBM Mainframe behavior. This has now been fixed.

3101399 (1108926)
• Previously, if using PUT EDIT LINE() with non-contiguous lines, there was an error in the calculation of

the number of lines that needed to be skipped via CTLASA control characters. This has now been fixed.

2884058 (1107881)
• A problem with PUT SKIP EDIT when driven from an ON ENDPAGE has been corrected.

2882729 (1107653)
• A problem with ASA Control characters when utilizing the language feature that skips to a new page

when the specified LINE is <= to the current line has been corrected.

2882011 (1107545)
• The MOD built-in fucntion now works correctly with fixed dec or pic variables.

2881986 (1107540)
• Previously, an unflushed stream file which contained a buffer that would cause it to match the

PAGESIZE of the file erroneously triggered ENDPAGE upon the close of the file. This no longer
happens.

2879623 (1107246)
• Previously, if using PUT PAGE; followed immediately by another PUT statement which included a PAGE

option, there were not two page ejects emitted as CTLASA characters. A secondary problem related to
using the RECSIZE() option of the ENV Attribute to establish a longer than standard LINESIZE for a
stream output file has also been corrected.
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2875866 (1106719)
• An undocumented IBM behavior with regard to the generation of CTLASA control characters for the

second line of the first page of a stream I/O file has been corrected.

2873492 (1106402)
• A problem with the comparison of two PIC variables which each contained multiple consecutive drift

characters has been corrected.

2869873 (1105854)
• Previously, if reading SYSIN via a PL/I Program compiled with -ebcdic, from a physical dataset in an

enterprise server region running in EBCDIC mode, the input was garbled. This no longer occurs.

2865346 (1105128)
• Previously, if using PUT SKIP(x) where x is greater than 1, on the first line of the first page of a PRINT

CTLASA file, the use of ASA control characters did not mimic the undocumented behavior present in
IBM's PL/I on z/OS. This has now been fixed.

2864096 (1104958)
• Previously, when a CTLASA file was OPEN(ed) and CLOSE(ed) without any data being written, a zero

length file was created. Open PL/I now matches IBM's behavior and emits a single blank page feed line.

2863818 (1104911)
• Previously, if using an EXTFH.CFG where the [XFH-DEFAULT] contained INSERTNULL=OFF, the

compiler would trap when compiling larger complex programs while attempting to read back in a
temporary file created during the parsing phase. This no longer occurs.

2863220 (1105599)

• ECM now generates correct code to drive user-specified labels in exec sql whenever goto xxx;
statements.

3105039 (1109297)
• The -optsql, -optcics, -optdli, and -optexec compiler options now support strings that can be as large as

2048.

2877088 (1106913)

REX Support

Back to the list

• When running a REXX EXEC under Enterprise Server or Enterprise Server for .NET, an "Invalid
Expression" error occurred for an assignment statement where the expression being assigned to the
variable had been omitted. An empty string is now assigned to the variable if the expression is omitted.

2880655 (1107390)
• A REXX exec could fail with a S0C4 abend or an RTS 114 error if it was greater than 4096 bytes in

length and specified either as in-stream data or catalogued as an RECFM=F or RECFM=V dataset.

2878613 (1107100)

RM/COBOL

Back to the list

• When FILETYPE(21) was specified for a LINE SEQUENTIAL print file, you could receive a Run-Time
System error "13". Writing to a printer from a Visual COBOL program through the RM File Manager
(filetype 21) now works correctly.

2874987 (1106616)

Run-Time System

Back to the list
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• Adis SCREEN SECTION ACCEPT statements for PIC N DISPLAY-1 items now correctly accept DBCS
characters with a lead byte of x"87".

3104586 (1109231)
• A error when using very long command lines with Profiler (or cobprof on UNIX) has been fixed.

2884968 (625185)
• You can now double-click (to run) managed executables that use the ACUFH file handler; previously,

they may have failed with a COBRT198 error.

2880827 (1107388)
• When debugging a native Object COBOL application, the debugger no longer fails with an intermittent

COBRT114 run-time error when getting the type and value of an object's handle.

2875531 (1106808)
• A multi-threaded application that makes use of the COBOL syntax for handling mutexes, monitors,

events and semaphores, or the corresponding CBL_ APIs, no longer fails intermittently with various run-
time errors due to memory corruption.

2860205 (1104446)
• Animating a core file that has been moved to a different directory, for a core file produced by an

application compiled to executable, no longer fails with a "Program is not animatable" error. Previously, it
would on certain platforms.

2856631 (1103933)
• Detaching from animation that was started using the debug_on_error tunable could cause animation to

re-start again for the initial error - this has now been resolved.

• In managed COBOL, a CANCEL data-name statement no longer fails or crashes if the contained
program name is not space-terminated.

2887392 (1108320)
• Using user-defined class conditions in managed code no longer gives incorrect results.

2887005 (1108290)
• When executing a SQLCLR stored procedure for a second time, programs not found during the first

execution might not be found dynamically.

2879012 (1107201)
• The backtab key now works correctly when performing ADIS screen i/o operations in managed code

applications.

2877480 (1106928)
• Using the CBL_FILENAME_CONVERT library routine resulted in receiving an exception in managed

COBOL if bit 3 was set for the function parameter and CTF tracing was then enabled.

2876179 (1106763)
• An environment variable with a value containing a leading space is no longer treated as having been

deleted.

2872919 (1106405)
• A CANCEL of a dataname containing low values no longer causes a Run-Time System error in

managed COBOL code.

2872140 (1106247)

• A 12-byte (32-bit) memory leak has been prevented when calling native COBOL code from JVM
COBOL when using the 'C' call-convention, or the RuntimeSystem.cobcall/cobrcall library APIs, with a
parameter type that is a JVM array.

SQL: COBSQL

Back to the list
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• A problem that caused the COBSQL preprocessor to incorrectly parse comments beyond column 72
has been fixed.

3101746 (1108980)
• A problem with COBSQL producing a duplicated cursor data item when KEEPCOMP was used has

been fixed.

2874051 (1106531)
• A problem that caused the COBSQL preprocessor to incorrectly process source lines with characters in

column 73 and beyond has been fixed.

2869958 (1109899)

SQL: OpenESQL

Back to the list

• The OpenESQL preprocessor incorrectly expanded a group host variable used in a CURSOR SELECT
statement, resulting in a run-time error. The preprocessor has been modified to generate a COBES0130
error message in this case.

3104602 (1109289)
• A problem the prevented OpenEQL applications calling SQL Server stored procedures with no

parameters when using the legacy 'SQL Server' ODBC driver has been fixed. Important: We strongly
discourage use of the legacy 'SQL Server' ODBC driver. Instead, we recommend that for best
performance and functionality, use the ODBC driver that corresponds to the version of SQL Server used
by the application.

3100550 (1109071)
• A problem with HCOSS code generation that occurred when duplicating input host variable references

(for example when substr() is used with 2 rather than 3 parameters) has been fixed.

3100098 (1108819)
• A problem with the OpenESQL native routine that provides DSNTIAR emulation sometimes caused an

RTS114 error. This has been fixed.

2989595 (1108699)
• A new OpenESQL directive, GEN-SQLCA, has been added to generate the SQLCA copybook in a

program when it has not been explicitly included. This directive provides additional support when
migrating applications compiled with STDSQL(YES) on the mainframe.

2887858 (1108368)
• A problem with the MSSQL XA switch module sometimes causing a CICS transaction to abort if it

ended without closing all FORWARD and READ ONLY cursors has been fixed.

2887074 (1108340)
• An inconsistency in reporting data truncation warnings when using PostgreSQL has been fixed.

2886648 (1108201)
• OpenESQL and OCI have been updated to to prevent RTS198 errors when using DSNTIAR with

ODBC. To take advantage of this new functionality, specify the cob -d command flag to resolve
DSNTIAR with the correct callable shared object. For example, to compile a COBOL program into an
executable on a 64-bit platform with OESQL DSNTIAR: cob -x program.cbl -d
DSNTIAR@cobmfdsntiar64.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm Or, to compile a PL/I
program into an executable on a 32-bit platform with OESQL DSNTIAR, execute the following two
commands: mfplx -c PROGRAM.pli -sql odbc -optsql "behavior=mainframe nosmftrace" cob -x
PROGRAM.o -d DSNTIAR@cobmfdsntiar.so -L$COBDIR/lib -lmfpliz -lplidump -llmgr -lm

2884651 (1107997)
• A problem when using OpenESQL for JDBC with the "Use Dynamic Calls" project option has been

fixed.
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2883500 (1107955)
• A problem with SQL(AUTOFETCH) that affected SQL Server FORWARD READ ONLY WITH HOLD

cursors performance has been fixed.

2880840 (1107580)
• The ADO.NET Run-Time System for OpenESQL now returns the correct value in SQLERRD(3) after a

cursor fetch when other statements are executed between any fetches on the cursor.

2880814 (1107386)
• OpenESQL now allows FREE to be used as an SQL identifier. It is server dependent if this is supported

at compile time when using SQL(CHECK) and at run time.

2880673 (1107368)
• A new OpenESQL directive, CLOSE_ON_COMMIT, has been added to provide greater control over

cursor behavior on COMMIT for cursors that are not explicitly declared using WITH HOLD.

2879558 (1107305)
• A problem with HCOSS handling of nested table references in DB2 statements has been fixed and error

messages when using SQL(STRICTPARSE) have been improved.

2879503 (1107286)
• The SQLBGP COBSQL compiler directive option has been added to ensure successful background

parsing of EXEC SQL statements when the Pro*COBOL installation resides on a remote machine and
not on the local machine.

2877618 (1107292)
• A problem that prevented SQL(CHECK) from working correctly on some databases has been fixed.

2877284 (1107021)
• When used with the SQL(USER-SQLDA=MAINFRAME) directive, the OpenESQL preprocessor could

incorrectly generate ES0100 errors if a group variable was used in an EXEC SQL FETCH statement.
This has been fixed.

2876420 (1106803)
• The OpenESQL preprocessor sometimes failed to return comp data items correctly if compiled with

SQL(DIALECT=MAINFRAME). This has been fixed.

2874931 (1106606)
• The OpenESQL preprocessor has been updated to generate a more meaningful message,

COBES0129, when it encounters an undefined host variable.

2874408 (1106624)
• A problem with SQL(NORSLOCATORS) leaking SQL Server server cursors has been fixed.

2872613 (1106294)
• HCOSS handling of the DB2 CHAR() function did not always properly apply the compile-time settings of

DATE and TIME as the default formats when CHAR was called with a date or time value but no date or
time format parameter was supplied. This has been fixed.

2872518 (1106404)
• A new SQL compiler directive option, OPTIMIZECURSORS, has been added to optimize memory

consumption when using OpenESQL for ADO.NET with Oracle, DB2, or PostgreSQL. The default
setting is SQL(OPTIMIZECURSORS=YES). See the OPTIMIZECURSORS reference topic in the
documentation for complete information.

2871132 (1106056)
• Decimal and host variables with the same length are now converted to EBCDIC correctly when

CHARSET(EBCDIC) is enabled; however, if you link native COBOL applications that use display
numeric variables in SQL statements using CHARSET(EBCDIC), you might get a link error. To resolve
this issue, see the OpenESQL topic under Known Issues and Restrictions.

2857755 (1104091)
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• A problem with the ODBC switch module not reporting broken connections to Enterprise Server when
xa_start() is called has been fixed.

2843672 (1108847)
• A problem that caused the OpenESQL preprocessor to incorrectly interpret UNICODE(PORTABLE) has

been fixed.
• The SQL xa_open string has been updated to include the PACKAGEPATH option, which enables the

use of substitution markers to customize the package path based on the current JCL or CICS user
name, XA resource name, enterprise server region name, or a combination. In addition, when used with
the UserP option, the PACKAGEPATH option value changes when the user for the connection changes.

• A problem using SQL(DATEDELIM) with SQL(DATE=JIS) has been fixed.
• OpenESQL has been updated to enable execution of selected SQL statements at compile time. You can

use this functionality to create temporary tables during compilation and to enable the use of
SQL(CHECK) with temporary as well as permanent tables.

• The encoding of the sqltype fields in SQLDA has changed and any applications that use dynamic SQL
with SQLDAs might require application code change. The new sqltype encoding scheme adds 0x2000
to sqltype when an integer, a small integer or a big integer host variable is COMP and 0x1000 and when
any indicator host variable is COMP. Otherwise, COMP-5 is assumed for indicators and for integer,
small integer and big integer host variables.

SQL Option for DB2

Back to the list

• A problem with the Declaration Generator that prevented COBOL copybooks from being generated
correctly for tables with timestamps and XML columns has been fixed.

2875742 (1106868)

• The XDB preprocessor has been updated to support source connect files that previously generated a
"File not found" error for EXEC SQL INCLUDE statements located on the source connect drive.

2912819 (1108471)
• The XDB ECM has been enhanced to handle temporal table query syntax.

2876438 (1106807)

• Implemented the JDBC ResultSet Interface getBigDecimal methods that do not require a scale
argument: getBigDecimal(int columnIndex) and getBigDecimal(String columnLabel).

2877817 (1106963)

• A problem that caused an X020 syntax error on SELECT DISTINCT (TRIM)has been fixed.

3105393 (1109324)
• A problem that prevented the XDB engines to successfully process a COUNT(DISTINCT expression)

scalar function when the expression was a concatenated expression enclosed in parentheses has been
fixed.

2884227 (1107903)
• A problem that caused a thread stack overflow on scalar function recursions that use CONCAT has

been fixed.

2884046 (1107882)
• A problem with the XUTLB LOAD grammar prevented the reserved word DATE from being used as a

table name. This has been fixed.

2882727 (1107652)
• An problem when correlating a subquery produced a PDMP242 error. This has been resolved.

2880672 (1107367)
• A problem that caused a FETCH FIRST clause in a scalar subquery to be ignored has been fixed.
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2880671 (1107366)
• A problem using the reserved word DOCUMENT as an identifier in the first argument of a scalar

function has been fixed.

2874154 (1106483)
• CAST AS TIMESTAMP using the special character 'T' as the date/time delimiter was not allowed. This

is now allowed.

2874153 (1106484)
• An issue with the ordering of a result set caused the incorrect row to be returned on a FETCH FIRST

ONLY clause. This has been fixed.

2873390 (1106435)
• An issue with index optimization of LIKE predicate processing has been resolved.

2873389 (1106391)
• A problem that sometimes caused the XDB Server to shut down before completing location checkpoint

operations by maintenance threads has been resolved.

2847090 (1102750)
• An problem with LIKE predicate index query optimization that caused missing result set rows has been

fixed.

2841168 (1101910)
• A problem that prevented the restoration of LOB data from a record with an LOB column after deleting

the record and then rolling back from a Save Point has been fixed.
• XDBMONN has been updated to issue the correct error message when it is started, but the server is

not running.

• The server Name be displayed in the status bar of the XDB SQL Wizard.

2865763 (1105197)
• Using ALLOW EDITING on an SQLWizard result set could result in the query being corrupted. This has

now been fixed.

2865336 (1105171)
• The restriction that prevented the editing of result sets generated from alias tables has been removed.

2857585 (1104067)
• When the SQLWizard is invoked by MFA Drag & Drop to import unload data to a table it no longer

returns an X352/X95 error.

XML Support

Back to the list

• XMLPARSE no longer returns -19 in XMLSS mode.

2913116 (1108661)
• Opened XML files are now closed when the COBOL program called by JCL is terminated.

2885450 (1108132)
• A new directive "OUTENC(INPUT)" is created to ensure encoding of the output text will be the same as

the input encoding specified in the XML declaration.

2870879 (1106332)
• XMLIO now handles REDEFINE data items correctly.

2795744 (1096302)
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Other Issues Resolved in This Release
The numbers listed are the Support Incident Numbers followed by the Reported Problem Incident (RPI)
number (in parentheses).

• 2884374 (1107928)
• 2875256 (1106645)
• 2871954 (1106649)
• 3103304 (1109198)
• 2857117 (1106716)
• 3106240 (1109462)
• 2989573 (1108689)
• 2874306 (1106666)
• 2848671 (1102872)
• 2878662 (1107084)
• 2864100 (1104959)
• 3101450 (1108990)
• 2884755 (1107973)
• 2884754 (1108098)
• 2883962 (1108118)
• 2883962 (1108119)
• 2878826 (1107101)
• 2878227 (1107012)
• 2877589 (1106938)
• 2875248 (1106679)
• 2874812 (1106627)
• 2874077 (1106516)
• 2872027 (1106210)
• 2869739 (1105894)
• 2868086 (1105954)
• 2864170 (1105040)
• 2864164 (1105035)
• 2990780 (1108760)
• 2884757 (1108096)
• 2883769 (1107830)
• 2851153 (1103313)
• 3101883 (1108971)
• 3101148 (1108902)
• 2885725 (1108103)
• 2884537 (1107964)
• 2878485 (1107076)
• 2876638 (1107036)
• 2872931 (1106328)
• 2872035 (1106199)
• 2867270 (1106437)
• 2837526 (1104757)
• 3101467 (1109005)
• 2879947 (1107389)
• 2879908 (1107247)
• 2878412 (1107371)
• 2852872 (1107046)

• 2989831 (1108862)
• 2875722 (1106767)
• 2875245 (1106642)
• 2858289 (1104218)
• 2839585 (1102006)
• 2869862 (1105851)
• 2857086 (1104025)
• 2831639 (1100766)
• 3102063 (1108996)
• 3101684 (1108956)
• 2884727 (1108008)
• 2881493 (1107488)
• 2860914 (1104582)
• 3105709 (1109380)
• 3105708 (1109382)
• 3105707 (1109383)
• 3105704 (1109377)
• 3105703 (1109374)
• 3105221 (1109372)
• 3105219 (1109379)
• 3105218 (1109371)
• 3105217 (1109375)
• 3105217 (1109376)
• 3105216 (1109370)
• 3105215 (1109368)
• 3105214 (1109369)
• 3104634 (1109245)
• 3103928 (1109267)
• 3103824 (1109284)
• 3102104 (1109041)
• 3101976 (1109010)
• 3101690 (1109039)
• 3101030 (1108911)
• 3101028 (1108930)
• 3101027 (1108932)
• 3100325 (1108856)
• 2988233 (1108531)
• 2912393 (1108452)
• 2912391 (1108451)
• 2912389 (1108442)
• 2912387 (1108439)
• 2912355 (1108501)
• 2912354 (1108450)
• 2887976 (1108736)
• 2887970 (1108418)
• 2887419 (1108331)
• 2886979 (1108286)

• 2879488 (1107196)
• 2877587 (1106984)
• 2877474 (1106937)
• 2877189 (1106921)
• 2874594 (1106590)
• 2874591 (1106575)
• 2874313 (1106592)
• 2873877 (1106610)
• 2872737 (1106316)
• 2872474 (1106964)
• 2871631 (1106297)
• 2869907 (1106670)
• 2869898 (1106147)
• 2869892 (1105900)
• 2869763 (1105896)
• 2864092 (1106070)
• 2852872 (1103790)
• 2852872 (1106311)
• 2852872 (1107278)
• 2799183 (1096680)
• 2991138 (1109121)
• 2875556 (1106727)
• 2873522 (1106485)
• 3101858 (1109029)
• 2883840 (1107954)
• 2882062 (1107704)
• 2871525 (1106466)
• 3106697 (1109529)
• 3109683 (1109781)
• 2871797 (1106201)
• 2816310 (1104173)
• 3100167 (1108936)
• 2989831 (1108879)
• 2796532 (1096369)
• 3105586 (1109338)
• 3105375 (1109313)
• 3102818 (1109347)
• 2875983 (1106861)
• 2875103 (1106822)
• 2988894 (1108994)
• 2870824 (1106018)
• 2875885 (1106721)
• 2886300 (1108160)
• 2883994 (1108116)
• 2876768 (1106926)
• 2875396 (1106686)
• 2887853 (1108380)

• 2881573 (1107673)
• 2878429 (1107279)
• 2876370 (1107219)
• 2871569 (1106143)
• 2867842 (1105600)
• 2867117 (1105493)
• 2853200 (1103409)
• 2885043 (1108044)
• 2876773 (1106847)
• 2869095 (1105803)
• 2865595 (1105786)
• 2860304 (1104472)
• 2883686 (1107844)
• 2865350 (1105129)
• 2864599 (1105025)
• 2873863 (1106487)
• 2870740 (1106000)
• 2866084 (1105259)
• 2864758 (1105772)
• 2989939 (1108666)
• 2878067 (1106990)
• 2877643 (1107028)
• 2873883 (1106635)
• 2819070 (1099603)
• 2657473 (1090356)
• 2869213 (1105788)
• 3103252 (1109178)
• 3103241 (1109176)
• 2991312 (1108795)
• 2887454 (1108358)
• 2882453 (1107614)
• 3100079 (1108823)
• 2887733 (1108399)
• 2880976 (1107464)
• 2877232 (1106950)
• 3102272 (1109059)
• 3101639 (1109086)
• 2886684 (1108370)
• 2884612 (1108024)
• 2879358 (1107190)
• 2878631 (1107110)
• 2877721 (1106966)
• 2876808 (1106856)
• 2876719 (1106845)
• 2875613 (1106730)
• 2873607 (1106420)
• 2873447 (1106429)
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• 2851640 (1103228)
• 2603382 (1087028)
• 2871769 (1106474)
• 2876285 (1106842)
• 3107224 (1109628)
• 2880556 (1107803)
• 2879876 (1107263)
• 2880593 (1107378)
• 3105620 (1109342)
• 2991280 (1108799)
• 2882386 (1107606)
• 2881902 (1107890)
• 2879176 (1107150)

• 2885859 (1108130)
• 2885529 (1108083)
• 2884236 (1108000)
• 2883551 (1107800)
• 2881659 (1107500)
• 2881243 (1107455)
• 2881040 (1107414)
• 2881038 (1107416)
• 2881037 (1107419)
• 2881036 (1107423)
• 2880647 (1107399)
• 2879819 (1107333)

• 2883907 (1107872)
• 2874406 (1106565)
• 2873249 (1106552)
• 2871661 (1106145)
• 2863482 (1104862)
• 2848848 (1102895)
• 2866216 (1105926)
• 2883667 (1107815)
• 2880475 (1107343)
• 2871842 (1106178)
• 3102432 (1109463)
• 2887808 (1108624)

• 2873158 (1106378)
• 2873035 (1106735)
• 2871178 (1106125)
• 2870557 (1106194)
• 2865051 (1105317)
• 2859144 (1104286)
• 2146936 (1059549)
• 2876653 (1106832)
• 2865001 (1105155)
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Unsupported Functionality
The following features or functionality are no longer supported:

• The HOSTSIGNS Compiler directive is no longer supported. Micro Focus recommends that you use the
following Compiler directives instead: SIGN-FIXUP, HOST-NUMMOVE, and HOST-NUMCOMPARE.
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Installation

Before Installing

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

On Windows

System Requirements

Hardware Requirements

The disk space requirements are approximately:

Enterprise Server

1 GB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note: This product can be installed on earlier versions of Windows but it has not been tested on
them.

Software Requirements

Note:

• The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

• This product includes OpenSSL version 1.0.2j.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs the .NET Framework 4.5.2 . You might need to
install the following version of the .NET framework manually, if it is targeted by your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.
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Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.
• .NET Framework 4.5.1 is provided with Windows 8.1 and Windows Server 2012 R2.
• .NET Framework 4.6.2 is provided with Windows 10 and Windows Server 2016.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in Enterprise Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric equivalent
(127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems. Also, active
content must be allowed and not blocked. To enable both these in Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file.

Click here to see this information on the Micro Focus Infocenter.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.
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• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open an  Enterprise Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Product Co-Existence
Note: The following applies to Windows only.

• Enterprise Developer and Enterprise Server (or Enterprise Test Server) cannot coexist on the same
machine.

• Enterprise Server and Enterprise Test Server cannot coexist on the same machine.

On UNIX

System Requirements

Hardware Requirements

The disk space requirements are approximately:

Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

POWER
running AIX

Micro Focus 421 MB 1.68 GB 842 MB 35 MB
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Platform Installer type Setup

file size

Disk space

required for

the installation

Disk space

required for

running

the product

Sentinel RMS

license
server

HP IA Micro Focus 814 MB 3.26 GB 1.63 GB 66 MB

System Z
running Red
Hat Linux

Micro Focus 339 MB 424 MB 678 MB 34 MB

x86-64
running Red
Hat Linux

Micro Focus 370 MB 480 MB 740 MB 44 MB

ppc64le
running Red
Hat Linux

Micro Focus 238 MB 224 MB 476 MB 1 MB

SPARC
running
Solaris

Micro Focus 418 MB 1.48 GB 836 MB 38 MB

x86-64
running
Solaris

Micro Focus 371 MB 840 MB 742 MB 30 MB

System Z
running SUSE
SLES

Micro Focus 210 MB 180 MB 420 MB 1 MB

x86-64
running SUSE
SLES

Micro Focus 376 MB 420 MB 752 MB 44 MB

ppc64le
running SUSE
SLES

Micro Focus 210 MB 480 MB 420 MB 1 MB

Operating Systems Supported

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements

Note: This product includes OpenSSL version 1.0.2j.

Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• Required libraries for Red Hat and SUSE Linux platforms - The installer checks that both the 32-bit and
64-bit libraries listed below are installed on both 32-bit and on 64-bit Operating Systems for this product
to install and work correctly.

If installing on a 64-bit OS, the 32-bit libraries are not installed by default and must be installed before
you start the installation.
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Library 32-bit
Library
Name

64-bit
Library
Name

Platform

s390 SUSE 11 SUSE 12 Red Hat 6.x Red Hat 7

glibc glibc-*.i686 glibc-
*.x86_64

glibc-
*.s390

X X

libgcc libgcc-
*.i686

libgcc-
*.x86_64

libgcc-
*.s390

X X

libstdc++ libstdc++-
*.i686

libstdc++-
*.x86_64

libstdc++-
*.s390

X X

elfutils-
libelf

elfutils-
libelf.i386
or elfutils-
libelf.i686

elfutils-
libelf.x86-6
4

N/A X X

libelf-devel elfutils-
devel.i386
or elfutils-
devel.i686

elfutils-
devel.x86-6
4

N/A X X

libelf-devel libelf-
devel-32bit-
0.137-8.19

libelf-
devel-0.137
-8.19

N/A X X

libelf1 libelf1-32bit
-0.137-8.19

libelf1-0.13
7-8.19

N/A X X

Visit the Red Hat Web site for more information.

• Oracle's Java Platform (64-bit) version 1.8.92 or above is required. Java 7 and 8 (32 or 64-bit versions)
are supported for executing JVM COBOL code and for native COBOL and Java interoperability. You can
download Oracle's Java EE from Oracle's Web site and install it anywhere on your machine.

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
is 7.0 Service Refresh 8. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX is JDK
7.0.11. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus License
Administration tool. For local servers, you do not need to install it separately, as the setup file installs
a new Enterprise Developer client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus License Administration tool. To check the version of the license server on UNIX, run /var/
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microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX

To ensure full functionality for some Enterprise Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the
Enterprise Server setup file.

Click here to see this information on the Micro Focus Infocenter.

Browser

Back to Top

Browser versions which can be used for embedded browser support (such as SWT) and their
corresponding Eclipse versions are listed here.

Note: Eclipse 4.5 and newer support Mozilla 1.4 GTK2 - 1.7.x GTK2, XULRunner 1.8.x - 1.9.x, 3.6.x,
10.x, 24.x and 31.x (but not 2.x nor other unlisted versions), WebKitGTK+ 1.2.x and newer (Eclipse
4.5 support for XULRunner 31.x is not available on Linux due to Bug 467646.). For Eclipse 4.6 you
must install a 64-bit browser version.

UNIX and Linux Installer Issues

Installing while using AFS/Kerberos authentication

If you are using AFS/Kerberos authentication to log onto your Linux system then you need to ensure you
have a local user ID which SOA and Enterprise Developer components of the product can use. This user
ID must be set up prior to running the installer. When running the installer you need to specify -
EDadminID=[User ID] on the command line so it is used by the installer.

License Server

You need to configure the computer hostname to ensure the license server will start properly.

To avoid performance issues, "localhost" and the computer hostname must not both be mapped to IP
address 127.0.0.1. You should only map "localhost" to IP address 127.0.0.1.

The following is an example of how to specify these entries correctly in the /etc/hosts file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.

Basic Installation
The instructions in this section apply when you are performing a basic installation of this product for the
first time. If you are an administrator, you can perform a basic installation on a local machine before
performing a more advanced installation when rolling out the product to developers within your
organization.

For considerations when installing this product as an upgrade, for additional installation options or non-
default installations and for installing the mainframe components, see Advanced Installation Tasks in your
product Help.
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Installing on Windows
Note: If there is an earlier version of Enterprise Server installed on your machine, check Installing as
an Upgrade first.

These are the steps to install this product:

1. Run the es_30.exe file and follow the wizard instructions to install the prerequisite software and the
product.

The setup file will also install any missing prerequisite software as listed in Software Requirements.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Program and Features
(Windows Vista or later), and rerun the installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with Enterprise Server but you can install it if you wish.

Installing on UNIX
Note: Micro Focus offers two types of installers on UNIX and Linux - a proprietary Micro Focus
installer for installing on UNIX and Linux and a standard RPM (RPM Package Manager) installer for
installing on Linux. See your product Help for instructions on how to use the RPM installer.

These are the steps to install this product using the Micro Focus installer:

1. Give execute permissions to the setup file:

chmod +x setup_ent_server_3.0_platform

2. Run the installer with superuser permissions:

./setup_ent_server_3.0_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/EnterpriseDeveloper,
(COBDIR).

Note:

During the installation process, the installer configures the product's Enterprise Server System
Administrator Process User ID. The Process User ID will be the owner of all Enterprise Server
processes except the one for the Micro Focus Directory Server (MFDS). The Directory Server process
(Enterprise Server Administration) runs as root as this allows it to access the system files and ports.

All Enterprise Server processes you start from Enterprise Server Administration run under the
Process User ID which can affects the file access and creation.
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By default, the installer uses the login id of the user that runs the installer for the Process User ID. To
change the user id after you complete the installation, execute $COBDIR/bin/casperm.sh.

SafeNet Sentinel considerations

• The installation of this product could affect the SafeNet Sentinel licensed components running on your
machine. During installation licensing is shutdown to allow files to be updated. To ensure the processes
running on your machine are not affected, you need to use the -skipsafenet option, which skips the
installation of SafeNet:

./setup_ent_server_3.0_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or shutdown the
running license daemons. If licensing needs to be updated later, remove the file and install Sentinel
RMS server manually.

Advanced Installation Tasks (Windows)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade
• Command line installation options

To see this information on the Micro Focus Infocenter, click here.

Installing as an Upgrade
Before installing, check Installation Restrictions and Requirements.

Installing this release as an upgrade will automatically uninstall any HotFixes of the older version of the
product you have installed on your machine.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise Server
configuration. To do this, on the Enterprise Server Administration home page, click Export and then
select Export Enterprise Server configuration and Security Manager definitions. This creates a
backup folder in the c:\programdata\micro focus\Enterprise Developer\MFDS. You can
restore the Enterprise Server configuration after installing this release - click Import on the Enterprise
Server Administration home page.

Enterprise Server Installation Options
To install Enterprise Server you run es_30.exe which contains a number of product .msi files (Windows
Installer packages). When run, es_30.exe performs some initial system checks then sequentially installs
the .msi files.

es_30.exe can take a number of parameters, enabling you to specify a number of different types of
installation:

• Standard Installation

Format:
es_30.exe
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Summary:
Full installation including License Manager and Enterprise Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
es_30.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
es_30.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
es_30.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
Enterprise Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line: es_30.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

Advanced Installation Tasks (UNIX)
This section includes instructions about how to perform a non-default installation, install this product as an
upgrade, or about how to install any additional components.

The advanced installation tasks include:

• Installing as an Upgrade - included in these Release Notes
• Command line installation options - included in these Release Notes
• Installing using an RPM installer on Linux - available in the product Help and in the Micro Focus

Infocenter

Click here to see this information on the Micro Focus Infocenter.

Installing as an Upgrade
This release works concurrently with the previous version of Enterprise Server, so you do not need to
uninstall it.

Install the latest version in a different location and set the environment to point to it. To do this, run the
Enterprise Server installer with the –installlocation option:

Installation | 53

http://documentation.microfocus.com/help/topic/com.microfocus.eclipse.infocenter.enterpriseserver.unix/GUID-C0249210-5A8D-4C74-9EF0-8BC0915E89F6.html


1. Execute the following command:

./InstallFile -installlocation="/opt/microfocus/EnterpriseDeveloper"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/EnterpriseDeveloper/cobsetenv

Note: cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installation Options

Installing into a different location

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./ -installlocation="full path of new location"

Note: You can use variables when specifying an absolute path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter the -
help option.

Configuring Enterprise Server

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ], where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file - for
example, -ESsysLog="/home/esuser/logs". The default location is /var/mfcobol/
logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command line -
for example, -ESadminID="esadm". The default user ID is the one that runs the installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Installing Silently

You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.f

You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA
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After Installing
• See Changes in Behavior or Usage in your product documentation and in the Release Notes for

important information about changes in this release that might affect existing applications.
• Check the Product Documentation section of the Micro Focus SupportLine Web site and the Micro

Focus Infocenter for any updates to the documentation which might have been uploaded.

On Windows
To access the Enterprise Server help:

• On versions of Windows 7 and earlier, select Start > All Programs > Micro Focus Enterprise Server
> Documentation from the Windows Taskbar.

• On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available
links for this product. In the Enterprise Server section, click Documentation.

This opens the online Micro Focus Infocenter in a browser. From the left-hand pane, select Enterprise >
Micro Focus Enterprise Server.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs in Control Panel.
3. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus Enterprise Server and Micro
Focus License Administration. Uninstalling only Enterprise Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

On UNIX
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Setting the Environment
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/EnterpriseDeveloper/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as /etc/profile, /etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_EnterpriseServer3.0.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• If you are unsure of what your license entitlement is or if you wish to purchase additional licenses,
contact your sales representative or Micro Focus SupportLine.

To start Micro Focus License Administration

Windows 7 and Earlier • From your desktop, click Start > All Programs > Micro Focus
License Manager > License Administration

Windows 8, 8.1, and
Windows Server 2012

• From the Start screen, click the License Administration tile

Windows 10 and Later • Click Start > Micro Focus License Manager > License
Administration

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses
You need either a license file (with a .mflic extension) or an authorisation code which consists of a 16-
digit string of letters and numbers.

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file

into the box below the License file field.
4. Click Install Licenses.
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1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note:

• It is not possible to install licenses remotely. You must be logged into the machine on which you
are installing the licenses.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter.

Authorizing your product when you don't have an Internet connection
This method of authorization is required if the machine you want to license does not have an Internet
connection or if normal (automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character

alphanumeric string supplied when you purchased your product.
6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
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9. Copy the generated license string (or copy it from the email) and paste it into the box under the License
file field on the Install page.

10.Click Install Licenses.

In order to authorize your product you must have the following:

• Access to a computer which is connected to the Internet.
• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for
Enterprise Developer, contact your sales representative or Micro Focus SupportLine.
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The Product Updates section of the Micro Focus SupportLine Web site, where you can download fixes
and documentation updates.

• The Examples and Utilities section of the Micro Focus SupportLine Web site, including demos and
additional product documentation.

• The Support Resources section of the Micro Focus SupportLine Web site, that includes troubleshooting
guides and information about how to raise an incident.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page, then
click Support & Services > Product Support. In the Browse by Product field, click the product you
require support for. Click Log into SupportLine.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Also, visit:

• The Micro Focus Community Web site, where you can browse the Knowledge Base, read articles and
blogs, find demonstration programs and examples, and discuss this product with other users and Micro
Focus specialists. See http://community.microfocus.com.

• The Micro Focus YouTube channel for videos related to your product - see https://www.youtube.com/
user/MicroFocusIntl.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
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(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) - a
tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On Windows, you can use the Micro Focus SupportLine Support Scan Utility, MFSupportInfo, to create
either:

• a .log file that contains the details about your environment, Micro Focus SupportLine products, and
settings.

• a .zip archive that includes the same information as the .log file plus some product configuration
files from c:\ProgramData and the product installation log files.

MFSupportInfo.exe is stored in <install-dir>\bin.

To run MFSupportInfo:

1. Start a 32-bit Enterprise Developer command prompt.
2. Enter MFSupportinfo at the command prompt to start the utility.
3. Create a .log file or a .zip archive as follows:

a. To create a .log file, click File > Save.

This prompts to save the .log file, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.log, in the %temp% directory.

b. To create a .zip archive, click Tools > Create Zip Package.

This creates a .zip archive, MFSupportInfo_Log_MachineName_YYYY-MM-DD_HH-MM-
SS.zip, in the %temp% directory.

4. Send the diagnostic information to your Micro Focus SupportLine representative:

The following requires an Internet connection and an Email client:

a. Click Tools > Email Log to SupportLine to open the Email Log dialog box.
b. Fill in the required fields and click Send.

If the machine is not connected to the Internet or if there are no Email clients installed, copy either
the .log file or the .zip archive to a machine that is connected to the Internet. Use your Email client
to email the files to Micro Focus SupportLine at supportline@microfocus.com together with the Support
Incident (SI) number, if available, and any additional details that might be useful to diagnose the issues
that you are experiencing.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.
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If COBDIR is set to a location that does not contain etc/cobver or COBDIR is not set, mfsupport
gives you the option to search your machine for possible product locations. Note that the search can
take some time if you have a large amount of disc storage and files.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Copyright and Disclaimer
Copyright © Micro Focus 2017. All rights reserved.

The only warranties for this product and any associated updates or services are those that may be
described in express warranty statements accompanying the product or in an applicable license agreement
you have entered into. Nothing in this document should be construed as creating any warranty for a
product, updates, or services. The information contained in this document is subject to change without
notice and is provided "AS IS" without any express or implied warranties or conditions. Micro Focus shall
not be liable for any technical or other errors or omissions in this document. Please see the product's
applicable end user license agreement for details regarding the license terms and conditions, warranties,
and limitations of liability.

Any links to third-party websites take you outside Micro Focus websites, and Micro Focus has no control
over and is not responsible for information on third party sites.

This product includes software developed by Computing Services at Carnegie Mellon University (http://
www.cmu.edu/computing/)".
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